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This symbol, found on your product or on its packaging, indicates that this
product should not be treated as household waste when you wish to dispose
of it. Instead, it should be handed over to an applicable collection point for the
recycling of electrical and electronic equipment. By ensuring this product is

disposed of correctly, you will help prevent potential negative consequences to the
environment and human health, which could otherwise be caused by inappropriate disposal
of this product. The recycling of materials will help to conserve natural resources. For more
detailed information about the recycling of this product, please contact your local city
office, household waste disposal service or the retail store where you purchased this

product.

X This equipment obtained certification by using 1.5M serial cable.
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1 Overview

1.1 Overview

PBH-101 is a programmable device for industrial network communication. You can build
various systems which are based on network using PBH-101 with many kinds of devices
such as a personal computer.

We provide a self-development programming language, which is called PHPoC, for
programing PBH-101. This language is easy to use and compatible with PHP which is
widely used script language.

&  PHPoC is basically compatible with PHP but those languages are not the same
because of restrictions about embedded system. Please refer to the “PHPoC

Language Reference Manual” and “PHPoC vs PHP” for detailed information.

1.2 Features

Provides Self-Development PHPoC Interpreter

® Provides simple development environment via USB

® Provides serial port with RS232/RS422/RS485 interface
® Provides 10/100Mbit Ethernet

® Provides IEEE802.11b/g Wireless LAN

® Provides development tool for Windows

@‘M SOLLAE SYSTEMS -5- https://www.eztcp.com
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1.3 Specification

Input DC 5V (£0.5V)
Power

Current about 235mA (without USB WLAN adapter)
Dimension 158mm x 90mm x 24mm
Weight about 347g (without USB WLAN adapter)

1 x RS232/RS422/RS485
(Baud Rate: 1,200bps ~ 230,400bps)

Serial

10 Base-T / 100 Base-TX Ethernet
Auto MDI/MDIX (cable auto-sensing)

Interfaces Network
IEEE802.11b/g

(require Ralink RT3070/5370 chipset WLAN adapter)

USB Host — for WLAN adapter

USB
USB Device — for PC

Firmware PHPoC Interpreter

Storage
Temperature ; -40 ~ 85°C

/Operating
Approval KC, FCC
Environment RoHS Compliant
Software PHPoC Debugger

Table 1-1 specification

SOLLAE SYSTEMS -6 - https://www.eztcp.com
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Dimension
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Figure 1-1 dimension

<  Dimensions may vary according to a method of measurement.
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1.5 Interface

1.5.1  Panel Layout

o (@ ©
_O ) | 0l 0]o

com USB DC5V || Func
D

w
-
wi

PBH-101

SOLLAE SYSTEMS

BRRAE

Figure 1-2 panel layout
@ LED PWR, STS, A~H
@ USB device port (Setup): PC connection, DC 5V power supply
® Ethernet port: 10/100M
@ Serial port: RS232 / RS422 / RS485
® USB host port: USB WLAN adapter connection
® Power: DC 5V
@ Function button (Func)

@3@- SOLLAE SYSTEMS -8- https://www.eztcp.com
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1.5.2 LED
LED Name Action
Power LED PWR turned ON with stable power supply
running PHP
> repeat On and Off in every second
Status LED STS
not running PHP
> briefly blinks 1 time at a time
User-defined LED A~H follows definition on user script

Table 1-2 LED

1.5.3 USB Device Port for connection with PC

The USB device port is to connect with PC. You can access to products via development

tool with connecting USB cable to this port. However, PBH-101 may not work properly in

case of supplying power via this port only due to insufficient current.

1.54  Function Button (Func)

The function button is used for changing mode to button setup mode.

1.5.5  Supplying Power

® DC 5V Input

This port is the main input port for supplying power. Specification is as follows:

@2.0

?6.3

@

@ oo

® USB Device port (Micro USB)

Figure 1-3 specification of power port

This port can be a sub input port for supplying power.

SOLLAE SYSTEMS
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1.5.6  USB Host Port for Connection with a WLAN adapter

PBH-101 provides a USB host port for an USB WLAN adapter. You can connect your
product to Wireless LAN by connecting a WLAN adapter to this port. Note that you cannot
use Ethernet (Wired LAN) while using this port.

&  Caution: Only adapters using Ralink RT3070/5370 chipsets are available.

e Caution: WLAN cannot be used with Ethernet at the same time.

1.5.7 Serial

PBH-101 provides one serial port interfaced to D-SUB 9pin male connector and you can
select the type of RS422, RS485 or RS232. Uploading PHPoC codes to your product is

required to set the type of serial.

O\ "oooe [O
® 0 ® 6

Figure 1-4 serial

&  Please refer to the "PHPoC Device Programming Guide for P20” for detailed

information about setting type of serial.

® Serial Port Specification

Parameter Value

The number of ports | 1

Serial Type RS232 / RS422 / RS485

Baud rate 1,200 ~ 230,400 [bps]

Parity NONE / EVEN / ODD / MARK / SPACE

Data bit 8 or 7(7 data bits is only available on using Parity)
Stop bit 1or2

Flow control NONE, RTS/CTS

Table 1-3 serial port specification

SOLLAE SYSTEMS -10 - https://www.eztcp.com
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Pin | Name [ Description Level I/O Note

1 DCD Data Carrier Detect RS232 - N/A

2 RXD Receive Data RS232 | In basic

3 TXD Transmit Data RS232 | Out | basic

4 DTR Data Terminal Reaéy ) RS232 | Out | optional

(always output active signal)

5 GND Ground - - basic

6 DSR Data Set Ready RS232 | - N/A

7 RTS Request To Send RS232 | Out | optional
8 CTS Clear To Send RS232 | In optional
9 RI Ring Indicator RS232 - N/A

Table 1-4 RS232 pin assignment
® RS422 pin assignment

Pin Name Description Level I/O Note

9 X + Transmit Data + RS422 Out basic

1 X - Transmit Data - RS422 Out basic

4 RX + Receive Data + RS422 In basic

3 RX - Receive Data - RS422 In basic

5 GND Ground - - basic

Table 1-5 RS422 pin assignment
® RS485 pin assignment

Pin Name Description Level I/O Note

9 TRX + Data + RS485 In/Out basic

1 TRX - Data - RS485 In/Out basic

5 GND Ground - - basic

Table 1-6 RS485 pin assignment

&  Biasing Register (100KQ) is connected to RS422/485 line.

SOLLAE SYSTEMS
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1.5.8 Ethernet

PBH-101 has Ethernet port which supports 10/100M bit Ethernet. Both direct and cross

over cable can be used because it automatically detects the type of cable.

® LED of RJ45 Connector

LED Operation State
ON Connected to Network
Green OFF Not connected to Network
Blink Receiving or Transmitting Network Data
ON Connected to 100M Ethernet
Yellow
OFF Connected to 10M Ethernet

Table 1-7 LED of RJ45 connector

SOLLAE SYSTEMS -12 - https://www.eztcp.com
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1.6 Development Environment

1.6.1  Overview

PBH-101 provides development environment over USB. PHPoC Debugger, which is
development software, is required to program to your product or to debug PHPoC source

codes.

1.7 PHPoC Debugger

1.7.1  Program Overview

PHPoC Debugger is a software running on Windows. This program does not require
installation. You can upload files to your product with this program through USB port.

Features of PHPoC Debugger are as follows:
® Upload files from local PC to PHPoC product
® Save files which are in PHPoC product to local PC
® Edit files stored in PHPoC product
® Debug PHPoC scripts
® Monitor PHPoC product resources
® Set PHPoC product

® Upgrade Firmware of PHPoC product

SOLLAE SYSTEMS -13 - https://www.eztcp.com



https://www.eztcp.com/

PBH-101 User Manual Ver. 1.2

1.7.2  Program Structure

OXCRC,

=
Watch | Resource|
Mame Type

Figure 1-5 program structure

@ SOLLAE SYSTEMS -14 - https://www.eztcp.com
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@ Menu bar

Menu Sub menu Description
Open a poc file Open a poc format file

File Save selected file(s) Save selected files in file list to local PC
Save a poc file Save all files in file list to local PC (.poc)
Undo Undo the latest job
Redo Redo the latest job undone
Cut Cut selected text and copy it to clip board
Copy Copy selected text to clip board
Paste Paste text of clip board

Edit Select all Select all text
Find Find specified text
Find Next Find the next text by down direction
Find Previous Find the next text by up direction
Change Replace specified text with given text
Preferences Program preference
Product / Firmware ) ]
i formation Information of current firmware and product
Network information Current network information
View PHP error log View firmware log messages in error
View firmware error log View firmware messages in error
Upgrade firmware Upgrade firmware

Function Reboot a product Reboot a product
View firmware log view firmware log messages
Firmware Debug mode Enable/disable Firmware debugging mode
PHP Debug mode Enable/disable PHP debugging mode
Font Change font
Language Change language
PHPoC Debugger )
oAt Information about PHPoC Debugger

Table 1-8 menu bar
SOLLAE SYSTEMS -15 - https://www.eztcp.com
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Menu Sub menu Description
View margin Show / Hide margin
View line number Show / Hide line number on margin
Vi View current line Enable / Disable current line emphasis
iew
Auto scroll Enable / Disable auto scroll
Line ratio Set line space: 100, 120, 150, 200, 300
Tab size Set tab size: 1, 2, 4, 8, 16
) Internal editor PHPoC Debugger internal editor
Action of : :
] External editor External editor
file add : .
Ask Show select option every time
Backup path Path of backup files
o Enter initialization S
Initialization Set product to initialization mode
mode
Table 1-9 preferences
@ COM PORT
Part for choosing a virtual USB COM port
(® Buttons
Button Description

Connect to PHPoC product

Disconnect to PHPoC product

Configure environmental values of PHPoC product

Upload files on [File list] to PHPoC product

Stop running PHPoC codes

Run / Pause PHPoC codes

Run line by line

EESOEEBD

Run procedure by procedure

Table 1-10 buttons

SOLLAE SYSTEMS
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@ File list
List of files in PHPoC product or to be uploaded to it

Icon Description

] Synchronized files

Y, Files on PHPoC product before synchronization

- Files on local PC before synchronization

1% ma | Synchronized files on local PC for external editors

Table 1-11 file list

Following menus will be popped up when right clicking on file list area.

Menu Description

New Create a new php file

Change the filename | Modify file name

Add Add files from local PC

Delete Delete file on the list

Table 1-12 pop up menu on file list
® Editor
Show and edit contents of selected file on the file list.

Following menus will be popped up when right clicking on editor area.

Menu Description Shortcut
Toggle Breakpoint Set / Unset break point on current line F9
Remove All Breakpoints Unset all break points on current file Shift+F9
Step Into Run line by line F11
Step Over Run procedure by procedure F10

Cut Cut selected codes and copy to clip board | Ctrl+X
Copy Copy selected codes to clip board Ctrl+C
Paste Paste codes on clip board Ctrl+V
Select all Select all codes Ctrl+A

Table 1-13 pop up menu on editor
® Flash memory size
This shows currently available or in-use space on flash memory of PHPoC product.

SOLLAE SYSTEMS -17 - https://www.eztcp.com
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@ Output / FW Log
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This window is for displaying standard output and F/W log messages.

The following menus will be popped up when right clicking on the windows.

1.2

Menu

Description

Delete all logs

Clear screen buffer

Copy a log

Copy selected log to clip board

Auto scroll

Set / Unset auto scroll

Table 1-14 pop up menu on output / console window

Watch / Resource

This window is for checking run time variable information and system resources.

The following menus will be popped up when right clicking on the watch window.

Menu Description
Add Add a variable
Modify Modify a name of selected variable
Delete Delete selected variables
Delete all Delete all variables
Detail Create a new window for detailed information
Refresh Refresh variables
Table 1-15 pop up menu on watch box
SOLLAE SYSTEMS -18 - https://www.eztcp.com
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2 Test Run

This chapter instructs how to program and execute provided example codes.
2.1 Development Environment Construction

2.1.1  Local PC

A MS windows PC is required to upload php files to the PBH-101 while creating and

modifying php files are available on other operating systems.

2.1.2  Connecting PBH-101

Connect PBH-101 to PC with a USB cable.

2.1.3  Running PHPoC Debugger

Run PHPoC Debugger on the PC.

&  This document defines "Upload” to "Sending files from a PC to PHPoC product.”

PBH-101

5

-

Upload

A
Local PC

Figure 2-1 definition of upload

@‘M SOLLAE SYSTEMS - 19 - https://www.eztcp.com
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2.2 Connecting Product

2.2.1  Connecting Product
Connect PBH-101 to a PC with a USB cable.
<  Device driver will be automatically installed when you connect PBH-101 to your PC.

When automatic installation fails, download and install the driver on ST Micro's

web site.

& STM32 USB Virtual Com Port Driver Download page:
https.//www.st.com/web/catalog/tools/FM147/CL1794/5SC961/551533/PF257938

2.2.2 Ready to Communicate

@ Run PHPoC Debugger
@ Select connected COM PORT and press connect (-!l) button.

@ If USB is successfully connected, connect button will be inactivated and disconnect

button (-!l) will be activated.

SOLLAE SYSTEMS - 20 - https://www.eztcp.com
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2.3 Practice

2.3.1  PHPoC Operation

PHPoC searches the "init.php" file right after it boots up. If there is no "init.php" file,

none of PHPoC code will be implemented. Thus, you must create or upload the "init.php"
file into PHPoC file system.

You can write a script on the "init.php" as well as running other php files using php

commands of system function. The "init.php" is implemented just once but loaded files by
the command can be repeatedly run.

&  Please refer to the “PHPoC System Function” document for detailed information
about system function.

® Running script on "init.php"

init.php

<?php

=

Figure 2-2 running script on "init.php"
® Running another php file in "init.php"

init.php a.php
<?php <7php

system(” php a.php");

T

=

Figure 2-3 running another php file in "init.php"

SOLLAE SYSTEMS -21- https://www.eztcp.com
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® Script run flow chart

C_ =D

Search "init.php"

Success?

Yes

Start to run "initphp"

load php file?

Yes

Run loaded php (Repeat) —( End )

Figure 2-4 flow chart of script run

= "initphp" is start of all scripts. It means that every php file is directly or indirectly

required to be loaded on "initphp" to run it

2.3.2 Default Files

PBH-101 is released with the following files uploaded.

File Name Description
/lib/sd_101.php Basic library of PBH-101
/lib/sn_tcp_ac.php TCP library
/lib/sn_tcp_ws.php Web socket library

/lib/sc_envs.php System ENV write library
Table 2-1 default files

SOLLAE SYSTEMS -22- https://www.eztcp.com
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2.3.3  Create "init.php"

® C(lick file list with the right button of your mouse and select [New] menu.

-
B8 PHPoC debugger EIM
File Edit Function
compor [cons EaEE
o SRR | [ (7riec petusser U1] E
S 2 - Menu : File, Edit, Function
3 - COM PORT : Select a COM port on your PC
—"1b S 4 - Buttons : Connect, Disconnect, Settings, Uploi=
= mmap e 5 - File list : List of files which uploaded or wil!
—R|g1'|t CIiCk 6 - Edit window : Space for editing php files
= nsole : Window for printing console message:
ew
Change the filename to use PHP OnChip Debugger]
(e * lonnect PHPoC product to your PC with USB cable.
DAz fter installing device driver, you can select a (
Change firmware elect the COM port and click the [Connectl button ~
| T 1 3
Output | FW Log Watch | Resource
|1 Name Type Value
] b

Figure 2-5 create "init.php" (1)

® [nput "init" into the file name box.

[ New S

Filename  init

| ! Create I Cancel

Figure 2-6 create "init.php" (2)

® Select init.php file in the file list.

COMPort  |CONT DRE=

S

i
File list EL
initphp 41byte 37>

4

Figure 2-7 select init.php

@@'— SOLLAE SYSTEMS -23- https://www.eztcp.com
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® Input the following command lines into the editor.

1 <?php
2lecho "Hello PHPoCYri\n™;
3|2
Figure 2-8 Hello PHPoC (1)

® C(lick upload button. (-)

® After PHPoC finishes uploading files, icon will be changed. (# — #)

2.34  Excecute Script

PHPoC automatically runs a script when it boots up or uploads file system. You can find
the result in the Output window of PHPoC Debugger.
Cutput
Hello PHPoC

Figure 2-9 result

= If [PHP debug mode] option of PHPoC Debugger is enabled, PHPoC does not

execute a script automatically. You can manually run the script by clicking the

Run button. ()

SOLLAE SYSTEMS -24 - https://www.eztcp.com
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2.4 Saving Files to PC

2.4.1  Saving File to PC

® Select files in file list

File list

init.php 41yte
= lib 3
= mmap W

Figure 2-10 saving files to PC (1)

® Click [File] > [Save selected file(s)] menu on menu bar

@ Edit Function

Open 2 poc file

Save selected file(s)

Save a poc file

Figure 2-11 saving files to PC (2)

® Choose a path and click [OK] button.

PBH-101 User Manual Ver. 1.2

Browse For Folder

Select a folder to save to,

I |4 Libraries

> & Roy

4 M Computer
I == Floppy Disk Drive (4:)
»| &L, Local Disk (C:) |
I cii DVD Drive (D)

[ 'rj Metwork

m

1

Folder: Local Disk {C:)

[ Make Mew Folder ] oK

Il Cancel |

Figure 2-12 saving files to PC (3)

@@; SOLLAE SYSTEMS -25-
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2.4.2  Save as a Integrated (.poc) file

® When you want to save all files on the file list as a single file, use [Save a poc file]

Edit Function

Open a poc file

menu.

Cave selected file(s)

Save 3 poc file

Figure 2-13 save as a poc file (1)

".poc" is filename extension. Input filename and click [Save] button.

F ™
B8 Save As u
@T::/}v|- Desktop » - |44 | | Search Desktop o

Organize = Mew folder s o= (7]
3 Favorites = liBrares F
Bl Desktop I ] Systemn Folder
4. Downloads
G| Recent Places | Roy
& System Folder -
- Libraries -
- . | Computer
@ Lrerm=ts - System Folder
J? Music
| Pictures % , Metwork b
B videos - _.II System Folder -
l File name: test I -
Save as type: | POC File(*.poc) v]
“ Hide Folders Save Cancel

Figure 2-14 save as a poc file (2)
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2.5 Upload Files to Product

PHP files in local PC can be uploaded to PHPoC products.

2.5.1 How to Add Files to File list

® Drag & Drop

Select and drag files on Window explorer to file list box and drop them.

Organize. % 020w Shatewith = Pa File Edit Function
7 Favorites Documents libraf} | coupon [coms : Cl- uE
B Desktop Source _ {z : 1:lpHpoc =
s | D
i Recent Places = File list
L] initphp.e* T ", 3‘-COM PO
s : 4 - Buttons
4 Libraries L test.php b | lib 3 5} e
=% » " - Fi
| & Documents Dra % mmap 3 s
: B - Edit win
J\ Music g “ [
: 7 - Console
!f Pictures Drop 8‘
B videns |
9[How to u:

Figure 2-15 add files to file list (1)

® Add menu

If you click [Add] after right-clicking in file list box, a window for selecting files will be

created. Selected files on the windows will be added to the file list.

File list q
3 - CON
b i fl - Butt
&= mmap # E - File
B - Edit
t ) e
-} MNew
ng ht Click Change the filename
Add 3
Dielete
Change firmware

Figure 2-16 add files to file list (2)

& Integrated file(.poc) should be added by [File]>[Open a poc file] menu only
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2.5.2  Upload files

Files in the file list will be uploaded to product by clicking upload () button. If the
uploading is completed, both files on the file list and in the product are synchronized with
changing (#) icons

File list

lib

mmap
init.php
test.php

Rk

Figure 2-17 upload files
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3 Management

3.1 Configure Parameters

All parameters including an IP address can be configured by PHPoC Debugger.

3.1.1  Configuration Procedure

@ Connect PHPoC product to PC.
@ Run PHPoC Debugger and click connect () button.
® After then, click configuration (ﬂ) button.

<  Sometimes you can see inactivated configuration button. In this case, click stop

D ) button before configuration.

@ Configure parameters

Settings - PBH-101 ‘ N [
Network | yireless LAN

IPv4
Local IP Address

(7 Use static IP address
Subnet Mask @ Obtain an IP Automatically(DHCF)

l . . . Cbtain DM5 Server Address Automatically
Gateway IP Address

DMS IP Address

IPvo

@ |Use static IP address

ELL (@) Obtain an IP Automatically

MAC Address -

Local IP Address |

N

|
Gateway IP Address | |
DMS IP Address | |

| Password | | certificate | | write || Close |

A . 3 h I

Figure 3-1 configuration window
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Tab

Category

Parameter

Network

Pv4

IP address

Subnet mask

Gateway IP address

DNS server IP address

IP address type - Use static IP address

IP address type - Obtain an IP automatically (DHCP)

IP address type - Obtain DNS server address automatically

IPv6

(scheduled to support in the future)

Wireless
LAN

Basic

Settings

WLAN - Enable / Disable

WLAN Topology - Ad-hoc / Infrastructure / Soft AP

Search AP / Search channel

Channel

SSID

Internal Antenna / External Antenna

Advanced Settings

Security
Settings

Shared Key

802.1X: EAP-TLS / EAP-TTLS / PEAP

Buttons

Password

Password (ID: Admin)

Certificate

Write self-signed certificate

Write signed certificate from certification authorities

Read the certificate form a product

Table 3-1 system parameters

&  Caution: PHPoC does not support restoration when you lose your password. You

can restore your product to factory default condition by using level 2 initialization

but all of your settings, files and the password will be deleted.
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3.2 Initialization

3.2.1 Level 1

Implementing level 1 initialization, both system parameters and user parameters
including stored certificate will be initialized to factory state. However, password and file

system will not be changed.

® Level 1 Initialization Procedure

Step | Action Product State STS LED
Press function button shortly
1 Button setup mode On
(less than 1 second)
Keep pressing the function button S Blink very
2 Preparing initialization i
over 5 seconds rapidly
3 Check STS LED after 5 seconds Initialization ready Off

After the step 3, release the

function button within 2 seconds S
4 Progressing initialization On
(After 2 seconds elapsed, state go

back to the step 3)

5 Rebooting automatically Initial state Off

Table 3-2 level 1 initialization procedure

=  WLAN easy setup function will be activated in the button setup mode in level 1

initialization. Thus, an STS LED can be blink if a wireless LAN client is linked.
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3.2.2 Level 2

When you implement level 2 initialization, all parameters including user password and file

system is initialized to factory state.

= Level 2 initialization should be used very carefully. Note that you had better to

back up your files to a local PC before doing this because they will be deleted.

® Level 2 Initialization Procedure

Step | Action Product State STS LED
Set PHPoC to initialization mode S )
) Enter Initialization mode Blink
1 (Use [Edit]>[Preferences] menu on )
after reboot rapidly
PHPoC Debugger)
Keep pressing the function button S Blink very
2 Preparing initialization .
over 10 seconds rapidly
3 Check STS LED after 10 seconds Initialization ready Off

After the step 3, release the

function button within 2 seconds o
4 Progressing initialization On
(After 2 seconds elapsed, state go

back to the step 3)

5 Initialization is finished Initial state Off

Table 3-3 level 2 initialization procedure
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3.3 WLAN Easy Setup

Product enters into button setup mode when you push function button in normal state.
In the mode, WLAN easy setup function is activated if an USB WLAN adapter is connected
SO you can access to your product by smartphone or laptop by WLAN.

33.1 SSID

Once WLAN easy setup function is activated in button setup mode, product uses SSID
including own MAC address like an AP. SSID is contained the second half of the product's
MAC address after "phpoc_" which is a prefix. For example, if the MAC address is
"0030f9060101", the SSID is "phpoc_060101".

3.3.2 WLAN Connection

Find your product's SSID via a smartphone or laptop.

phpoc_060101 ol ‘ |
Figure 3-2 WLAN connection
333 DHCP

While using WLAN easy setup function, a mobile automatically gets a dynamic IP address
from your product. The IP address of your product is fixed to 192.168.0.1 and mobile
obtains an IP address in 192.168.X.X range.

3.34 Access to Product

After uploading setting page to product, you can access to it by web browser.

ssnee SKT = PM 5:46
| 192.168.0.1

0O = all 60% @ PM 5:47

|192.1aa.0.1 I E

SOLLAE SYSTEMS

SOLLAE SYSTEMS

PBH-101

PBH-101

System Information System Information

Product name PaH-101
Product name PBH-101

BB b AR

Figure 3-3 mobile connection (left: iOS, right: Android)

&  WILAN easy setup function is available on connecting a USB WLAN adapter.
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3.4 Web Interface

PHPoC provides web interface regardless of script execution. TCP 80 is used for web
interface and you can use the interface via Internet Explorer, Chrome or any other web

browser.

34.1 How to use web interface

To use the web interface, "index.php" file should be in the file system of PBH-101.

Connect to this page by entering device IP address after connecting it to network.
i

@) ol

/ [ PHPaC x \_
|« C f |[1192168.0.1 TS

Hello World

Figure 3-4 web interface (1)
If the name of file is not "index.php", just specify the name of file after the IP address

with slash mark.

g 2 — = EE N
/' [ PHPoC *x N

€ - ¢ #i[[)1921680.1/aphp O 4 &=

Hello World

Figure 3-5 web interface (2)

3.4.2 Practical Use of Web Interface

A web interface is very useful because it runs while PBH-101 is operating in button setup
mode. If you upload web pages for running any function, you can easily use it by wireless
LAN.
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3.5 Firmware Upgrade

3.5.1 Download Firmware File

Check and download firmware file on PHPoC web site to your local PC.

3.5.2 Firmware Upgrade
@ Connect setup port of PHPoC product to local PC via USB cable.

@ Run PHPoC Debugger and click connect () button.
® Click [Function] > [Upgrade Firmware] menu.

- ES PHPoC debugger
Product/Firmware information =
Metwork information
Wiew PHP error log gger UI]

File Edit

COM Port

File list a

Wiew firmware error log

Upgrade firmware : Conm

Reboot a product ist of files

Figure 3-6 firmware upgrade (1)
@ Click [Open] button to select the firmware file.

F b
Upgrade firmware ﬁ

| Path : | [ Open l

| | Send

Figure 3-7 firmware upgrade (2)
® Click [Send] button.

F ki
Upgrade firmware M

[Path : Z\6.PHPoC\stm32(4\P20R10A_77.POC | [ open |

| |I Send I

Figure 3-8 firmware upgrade (3)

® Firmware Upgrade Completed.

F B
PHPoC Debugger ﬂ

J Firmware has been transmitted.

Figure 3-9 firmware upgrade (4)
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In case that you want to use not PHPoC Debugger's internal editor but external editor,

just set [External editor] option of [action of file add] item on preferences window.

oac

File it § Function
con Undo Ctrl+Z
Redo Ctrl+Y
[: <?php
Cut Ctrl+X
File - R
Copy Cirl+C P
m Paste Ctrl+Vv
Select all Ctrl=4
Find Ctrl+F
Find Mext F3
Find Previous Shift+F3
Change Ctrl+H

Preferences !—’

=
Preferences

View
View margin
Wiew line number
View current line
Auto scroll

Line rato
Tab iz

Action of file add
() Internal editor

() Ask

Backup path

F:WUserSWRoyWDommentsWPHPoCD

Initialization
[ | Enter initialization mode

Change

[-ﬁppl?

] [ Cancel ]

Figure 3-10 using external editor (1)

Upload php files with this option, synchronized files have lock icons as follows. Files with

this icon cannot be modified by PHPoC Debugger's internal editor but external editors

available.

@ SOLLAE SYSTEMS

File list
= lib 3
[ mmap
init.php -
task0.php # -

Figure 3-11 using external editor (2)
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3.6.2 PHP Debug Mode

PHPoC provides run-time debugging function. Buttons for debugging are enabled when
you check the PHP debug mode option in PHPoC Debugger. In this mode, you can set
break points or check values of variables at every command line.

= PHPoC debugger
File Edit JFunction |
Product/Firmware information
COM Port . .
Metwork information

E] - View PHP error log

File list View firmware error log

Upgrade firmware

] ik

- Reboot a product

) mma
initphg " Firmware debug mode
taskl.g v  PHP debug mode

Font

Figure 3-12 enable debug mode (1)
When enabling debug mode, PHPoC pause running script at the first line.

.
S PHPoC debugger
File Edit Function

COMPort | COMS n
Bls o0 [0 |z

File list 2?
init.php 41byte 37>
‘ = lib # 4

= mman e

Figure 3-13 enable debug mode (2)
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3.6.3 Escape Infinite Reboot Problem

PHPoC basically runs scripts when it boots up. Therefore, it is possible that a PBH-101
cannot be escape from infinite reboot by system command such as "reboot". To solve this
problem, it is required to stop the running script. Refer to the following.

@ Entering ISP mode

Make PBH-101 to enter ISP mode by supplying power while pressing FUNC button. In
the ISP mode, you can access to PHPoC by PHPoC Debugger without running a script.
@ Connect to PHPoC
Connect a PC to PHPoC via a USB cable and connect to the port via PHPoC Debugger.
A message window related with ISP mode will be popped up.

® Reboot PHPoC
Reboot PHPoC by using "Reboot a product” menu in PHPoC Debugger. After
rebooting, PHPoC stops running script even it is not in the ISP mode.

@ Correct source code

Correct the source code to prevent infinite reboot state.
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4 Technical Support and Warranty

4.1 Technical Support

Sollae Systems operates PHPoC forum web site. This forum is for solving problem, asking

questions and sharing opinions among PHPoC users.

® PHPoC Forum: https://forum.phpoc.com

4.2 Customer Support

If you have any question regarding products, service and others, visit message board of

Customer Support on Sollae Systems’ web site or send us an email:

® Q & A board: https://www.eztcp.com/en/support/gna.php

® E-mail: support@eztcp.com

4.3 Warranty

431 Refund

Upon the customer’s request to refund the product within two weeks after purchase,

Sollae Systems will refund the product.

4.3.2 Free Repair Services

For product failures occurring within two years after purchase, Sollae Systems provides
free repair services or exchange the product. However, if the product failure is due to
user’s fault, repair service fees will be charged or the product will be replaced at user’s

expense.

4.3.3 Charged Repair Services

For product failures occurring after the warranty period (two years) or resulting from
user’s fault, repair service fees will be charged and the product will be replaced at user’s

expense.
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Precaution and Exemption from Liability

5.1 Precaution

® Sollae Systems is not responsible for product failures occurring due to user's

alternation of the product.

® Specifications of the product are subject to change without prior notice for

performance improvement.

® Sollae Systems does not guarantee successful operation of the product if the

product was used under conditions deviating from the product specifications.

® Reverse engineering of firmware and applications provided by Sollae Systems is
prohibited.

® Use of firmware and applications provided by Sollae Systems for purposes other

than those for which they were designed is prohibited.

® Do not use the product in an extremely cold or hot place or in a place where

vibration is severe.

® Do not use the product in an environment in which humidity is high or a lot of oil

exists.
® Do not use the product where there is caustic or combustible gas.

® Sollae Systems does not guarantee normal operation of the product under the

conditions a lot of noise exists.

® Do not use the product for a purpose that requires exceptional quality and
reliability relating to user’s injuries or accidents — aerospace, aviation, health care,

nuclear power, transportation, and safety purposes.

® Sollae Systems is not responsible for any accident or damage occurring while using

the product.
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5.2 Exemption from Liability

5.2.1 English version

In no event shall Sollae Systems Co., Ltd. and its distributors be liable for any damages
whatsoever (including, without limitation, damages for loss of profit, operating cost for
commercial interruption, loss of information, or any other financial loss) from the use or
inability to use the PBH-101 even if Sollae Systems Co., Ltd. and its distributors have been
informed of such damages.

The PBH-101 is not designed and not authorized for use in military applications, in
nuclear applications, in airport applications, in applications involving explosives, in medical
applications, in security alarm, in a fire alarm, in applications involving elevators, or in
embedded applications in vehicles such as but not limited to cars, planes, trucks, boats,
aircraft, helicopters, etc.

In the same way, the PBH-101 is not designed, intended, authorized to test, develop, or
be built into applications where failure could create a dangerous situation that may result
in financial losses, damage to property, personal injury, or the death of people or animals.
If you use the PBH-101 voluntarily or involuntarily for such unauthorized applications, you
agree to subtract Sollae Systems Co., Ltd. and its distributors from all liability for any claim
for compensation.

Sollae Systems Co., Ltd. and its distributors entire liability and your exclusive remedy shall
be Sollae Systems Co., Ltd. and its distributors option for the return of the price paid for,
repair, or replacement of the PBH-101.

In no event shall Sollae Systems Co., Ltd. and its distributors be liable for loss of user
program codes which are stored in PBH-101.

Sollae Systems Co., Ltd. and its distributors disclaim all other warranties, either expressed
or implied, including, but not limited to, the implied warranties of merchantability and
fitness for a particular purpose, with respect to the PBH-101 including accompanied written

material, hardware and firmware.
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5.2.2 French version

® Documentation

La documentation du boitier PBH-101 est congue avec la plus grande attention. Tous les
efforts ont été mis en ceuvre pour éviter les anomalies. Toutefois, nous ne pouvons garantir
que cette documentation soit a 100% exempt de toute erreur. Les informations présentes
dans cette documentation sont données a titre indicatif Les caractéristiques techniques
peuvent changer a tout moment sans aucun préavis dans le but d'améliorer la qualité et les

possibilités des produits.

® Copyright et appellations commerciales

Toutes les marques, les procédés, les références et les appellations commerciales des

produits cités dans la documentation appartiennent a leur propriétaire et Fabricant respectif.

® Conditions d'utilisations et limite de responsabilité

En aucun cas Sollae Systems Co., Ltd. ou un de ses distributeurs ne pourra étre tenu
responsable de dommages quels qu'ils soient (intégrant, mais sans limitation, les
dommages pour perte de bénéfice commercial, interruption d'exploitation commerciale,
perte d'informations et de données a caractére commercial ou de toute autre perte
financiére) provenant de I'utilisation ou de l'incapacité a pouvoir utiliser le boitier PBH-101,
méme si Sollae Systems Co., Ltd. ou un de ses distributeurs a été informé de la possibilité
de tels dommages.

Le boitier PBH-101 est exclusivement prévu pour un usage en intérieur, dans un
environnement sec, tempéré (+10 °C a +40°C) et non poussiéreux. Le boitier PBH-101 n'est
pas prévu, ni autorisé pour étre utilisé en extérieur, ni de facon embarquée dans des engins
mobiles de quelque nature que ce soit (voiture, camion, train, avion, etc..), ni en milieu
explosif, ni dans des enceintes nucléaires, ni dans des ascenseurs, ni dans des aéroports, ni
dans des enceintes hospitaliers, ni pour des applications a caractére médical, ni dans des
dispositifs de détection et d'alerte anti-intrusion, ni dans des dispositifs de détection et
d'alerte anti-incendie, ni dans des dispositifs d'alarme GTC, ni pour des applications
militaires.

De méme, le boitier PBH-101 n'est pas congu, ni destiné, ni autorisé pour expérimenter,
développer ou étre intégré au sein d'applications dans lesquelles une défaillance de celui-ci
pourrait créer une situation dangereuse pouvant entrainer des pertes financiéres, des
dégats matériel, des blessures corporelles ou la mort de personnes ou d'animaux. Si vous
utilisez le boitier PBH-101 volontairement ou involontairement pour de telles applications
non autorisées, vous vous engagez a soustraire Sollae Systems Co., Ltd. et ses distributeurs

de toute responsabilité et de toute demande de dédommagement.
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En cas de litige, I'entiere responsabilité de Sollae Systems Co., Ltd. et de ses distributeurs
vis-a-vis de votre recours durant la période de garantie se limitera exclusivement selon le
choix de Sollae Systems Co., Ltd. et de ses distributeurs au remboursement de votre
produit ou de sa réparation ou de son échange. Sollae Systems Co., Ltd. et ses distributeurs
démentent toutes autres garanties, exprimées ou implicites.

Tous les boitiers PBH-101 sont testés avant expédition. Toute utilisation en dehors des
spécifications et limites indiquées dans cette documentation ainsi que les court-circuit, les
chocs, les utilisations non autorisées, pourront affecter la fiabilité, créer des
dysfonctionnements et/ou la destruction du boitier PBH-101 sans que la responsabilité de
Sollae Systems Co., Ltd. et de ses distributeurs ne puissent étre mise en cause, ni que le

boitier PBH-101 puisse étre échangé au titre de la garantie.

® Rappel sur I'évacuation des équipements électroniques usagés

Le symbole de la poubelle barré présent sur le boitier PBH-101 indique que vous ne
pouvez pas vous débarrasser de ce dernier de la méme fagcon que vos déchets courants.
Au contraire, vous étes responsable de [I'évacuation du boitier PBH-101 lorsqu'il arrive en
fin de vie (ou qu'il est hors d'usage) et a cet effet, vous étes tenu de le remettre a un
point de collecte agréé pour le recyclage des équipements électriques et électroniques
usagés. Le tri, I'évacuation et le recyclage séparés de vos équipements usagés permettent
de préserver les ressources naturelles et de s'assurer que ces équipements sont recyclés
dans le respect de la santé humaine et de I'environnement. Pour plus d'informations sur les
lieux de collecte des équipements électroniques usagés, contacter votre mairie ou votre

service local de traitement des déchets.
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6 Appendix

6.1 Device Information

6.1.1 Device overview

Device Number | Path Note
UART 1 /mmap/uart0
NET 2 /mmap/net0~1 0: wired, 1: wireless
TCP 5 /mmap/tcp0~4
UbpP 5 /mmap/udp0~4
I/O - Digital Output (LED) | 8 /mmap/io3
ST 4 /mmap/st0~3
Table 6-1 device overview
6.1.2 1/O port
Type Path and Mapping information
/mmap/io3
#15 #14 #13 #12 #3 #2  #1  #0
HED H|G|F|E D|C|B|A
MSB “/mmap/io3"” LSB
/mmap/iod
#3 #2 #1 #0
SET SET SET SET
R5485 422 RE RS422 RS232
MSB “/mmap/io4” LSB
UART Mode / P/
(Serial Type) ® Values for Serial Type
Type | Value | SET RS485 SET 422 RE SET RS422 SET RS232
RS232 | Ox05 | O 1 0 1
RS422 | 0x02 | O 0 1 0
RS485 | OxOc | 1 1 0 0

Table 6-2 1/O port

&  Refer to the “Device Programming Guide for P20” for detailed information about

using devices.
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7 Revision History

Date Version | History Author

2014.10.23. | 1.0 Created Roy Lee

2015.11.10. | 1.1 Updated screenshots Amy Kim

2020.05.13. | 1.2 O Modify contents about approval in the Specification Roy LEE
O Correct some errors
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